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What you need to know already 

The instructions in this manual assume that you are familiar with basic 
Macintosh operations (such as click, choose, drag, drop, copy, move) and 

Macintosh elements (such as the Finder, dialog boxes, windows, pull-down 
and pop-up menus, fonts, font suitcases, aliases, Balloon Help, and Apple 
Guide). 

Explanations of these terms can be found in the documentation that came 
with your Macintosh. 

Conventions used in this manual 

o 

To hefp you find information, this manual adheres to the following 
conventions: 

  

Indicates a warning. This conveys essential information to help you avoid a 
potentially serious problem. 
  

  

NOTE: Indicates valuable information you need to know. 
  

  

TIP: Indicates special information that tells you how to do something more 

efficiently. 
  

Initial Caps — Indicates a pull-down menu command, or the name of an 
object, such as a menu, dialog box, or an option in a dialog 

box. 

Bold Indicates an AppleScript verb.



  

Preface 

Minimum hardware and software requirements 

To Use Suitcase 3.0. you need: 

® Any Macintosh, Power Macintosh, or compatible computer (68020 
processor or better) except for models 128K, 512K, 512Ke, Plus, SE, 

Classic, Porttble, or PowerBook 100 

x Macintosh OS version 7.1 or later 

Drag and drop from the Finder is available if you are using Macintosh 
OS version 7.5 or later, or with System 7 Pro (7.1.1) or System 7.1.2 if 
you allowed the Suitcase installer to install the Macintosh Drag and 

Drop extension (automatic if you choose the Easy Install option during 
installation, optional if you choose Custom Install). 

mw At least 4 MB of RAM 

a 2 MB of hard disk space 

ae To use Apple Guide: Apple Guide 2.0 extension (for Macintosh OS 

version 7.1 or later) or Apple Guide 1.0 extension and above (for 
Macintosh OS version 7.5 or later) 

  

Introduction 

  

Welcome to Suitcase 3.0! 

Suitcase now has an easier-to-use interface and powerful new features that 
help you organize and manage your fonts, and give you more font-handling 
capabilities than ever before. - 

Why you need Suitcase 

If you haven't used Suitcase, most of your fonts are probably in your System 
Folder, which means the Macintosh OS opens all your fonts every time you 
start up your Macintosh. Having all your fonts open all the time can be a 
problem because you probably have fonts open that you don’t need, 
consuming memory and slowing down your Macintosh. Or, you may even 
have so many fonts that the Macintosh OS simply cannot open them all. 

Suitcase solves these problems by letting you keep fonts (as many as you 
want) outside of the System Folder. You can still access them conveniently, 
plus you can turn them on only when you need them, and then turn them off 
as soon as you're finished with them, releasing Macintosh memory resources 
and helping your Macintosh run better. 

What you can do with Suitcase 

in addition to keeping your fonts outside your System Folder where you can 
turn them on and off as needed, Suitcase also allows you to: 

a Combine font files (or font folders, font suitcases, or sound files) into 

sets, sO you can open and close groups of fonts as needed 

a Have Suitcase open specific fonts Cand sounds) when you launch an 
pplication 

mw Have Suitcase open specific fonts whenever you start your 
Macintosh 

s Open fonts temporarily 

® Access fonts on remote hard drives 

a Quickly determine which fonts are open on your Macintosh 
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Figure 2-1 
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About Suitcase sets 

To use Suitcase, you put control of managing fonts on your Macintosh in the 
hands of the Suitcase application by placing fonts in Suitcase sets. Suitcase 
provicles three types of sets to make it convenient for you to organize your 
fonts and open and close fonts as you need them: 

w= font sets 

Create font sets to hold fonts that you want to be able to open and 
close as you need them. 

a Startup Set 

Use the Startup Set to hold fonts you want Suitcase to open every time 
you start your Macintosh. 

a application sets 

Create application sets to hold fonts you want Suitcase to open 
whenever you fiunch a particular application. 

Getting the most benefit from Suitcase 

As you probably know if you've used Suitcase before, you'll get the most 
benefit from Suitcase if, before using it, you move your fonts out of your 
System Folder. This is because Suitcase allows you to access fonts from 
outside of the System Folder, instead of keeping them inside the System 
Folder and requiring your Macintosh to keep them all open all the time, 
consuming, memory resources, 

Creating sets 2-3 

  

Another good thing to do before you start using Suitcase is to group fonts on 
your Macintosh, as much as possible, in the way you plan to group them in 
sets in Suitcase. For example, group all the fonts you want to open at startup 
in a single folder, Then drag the entire folder from your hard drive and drop 
it on the Startup Set in the Suitcase Sets window. This is much faster than 
fineling and adding each font separately to the Startup Set. 

See Appendix B, “Organizing your fonts,” for suggestions on removing your 
fonts from your System Folder and organizing them in folders on your 

Macintosh. 

Creating sets 
  

  
NOTE: Drag and drop from the Finder, mentioned throughout this chapter, is 
available if you are using one of the following: 
m Macintosh OS version 7.5 Cor later) 
a System 7 Pro (7.1.1) or System 7.1.2 with the Macintosh Drag and Drop 

extension installed 
  

Creating font sets using drag and drop 

1 In the Finder, choose a folder. 

The folder can contain any combination of font files, font suitcases, or 

sound files. (You cannot drag and drop individual font files, font 
suitcases, and sound files into the Sets window to create a new set, but 

you can add them to existing sets.) 

2 Drag and drop the folder or icon into the Sets window (Figure 2-2). 

A new set appears, assigned the same name as the original folder. The 

name of the new set is highlighted for you to change.



  

    

26 Quick start 

  

cE : e So 

* e 

hollow bullet (0) is shown. HW aif items in a set are closed, the open Installing Su ltca se 
column is empty. A yellow warning icon in this column designates an 

item of a sel containing items that were not opened because fonts with 
the same name are already open on your Macintosh. 

  

This chapter gives detailed step-by-step instructions on how to install and 
launch Suitcase. 

  

If you're upgrading from a previous version of Suitcase, do not move or 
@ delete the old Suitcase extension from the Extensions folder in your System 

Folder. Suitcase needs it to convert your old sets to Suitcase 3.0 sets. 
  

1 Make sure your Macintosh hardware and software meet the 
requirements described in “Minimum hardware and software 
requirements” in the Preface of this manual. 

2 Insert the Suitcase Installation Disk into your floppy drive. 

A window displaying the contents of the disk opens (Figure 3-1). 

Figure 3-1 
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3 Optional: Double-click the Read Me icon to see any late-breaking 
information about Suitcase that arose after this manual went to press. 

4 Double-click the Installer icon. 

5 . Click Continue in the dialog box that appears. 

The Suitcase Installer dialog box appears (Figure 3-2).  



  
  

3-4 installing Suitcase     
9 Ctick Install. The Suitcase Sets window appears (Figure 3-7). 

If an alert box appears telling you that installation cannot take place 
while other applications are running, you have two choices: Figure 3-7 

m Click Continue to close the other applications and continue 

  

  

  

      
  

  

      
  

installing 

a Click Cancel to quit the Installer and save any open files before 
quitting all open applications and Jaunching the installation again Heme Size_Kind Open Compressed 
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If problems persist, hold down shift as you restart your Macintosh (this 
starts the Macintosh with extensions off) and try installing again. 

When installation is finished, a dialog box appears telling you that 

installation was successful and you need to restart your Macintosh to | 
use Suitcase (Figure 3-6). 

pb Infe fwew set ]{ add. | (Clase {Open ) 

Figure 3-6 

12 For information on using Suitcase, go to Chapter 4, “Managing your 
Fe) Instaliation was successful. You must fonts,” or use Suitcase Guide. 

now restart your Macintosh to use your . . . . . . 
new software, To use Suitcase Guide, make sure Suitcase is the active application, 
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your Macintosh menu bar. 
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100 Click Restart. 

  

Suitcase 3.0 Folder. Suitcase needs it to convert your Suitcase 2.0 sets 

@ Do not move or delete the Suitcase 2.x Database icon from the 

to Suitcase 3.0 sets. 
  

11. When your Macintosh restarts, launch Suitcase by choosing the 
Suitcase 3.0 alias from the Apple menu, or by double-clicking the 
Suitcase 3.0 icon in the Suitcase 3.0 Folder. 

Suitease 3.0 

  

NOTE: If you're upgrading from a previous version of Suitcase, a 

dialog box appears asking if you want to convert your old sets into 
Suitcase 3,0 sets, Click OK, 
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Managing your fonts 

Why Suitcase has different kinds of sets 

To make opening fonts as automatic and convenient as possible, Suitcase 
provides two special kinds of sets in addition to the basic font set: the startup 
set and the applicetion set (Figure 4-1). 

Figure 4-1 The Sets window 
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Startup Set 

The Startup Set is for fonts that you want Suitcase to open when you start up 
your Macintosh. Any font that you use all or most of the time should be 
placed in the Startup Set. The Startup Set is a permanent feature of the 
Suitcase window: it cannot be renamed or removed. 

Application sets 

You can create Application sets for fonts you want Suitcase to open 

whenever you launch particular applications. When an application set is 
opened, these fonts are available to all other applications on your Macintosh. 
When you quit the application, the fonts in its application set remain 
available until you close them in the Sets window, or until you shut down 
your Macintosh. 

Getting the most benefit from Suitcase 

Before you start using Suitcase, to get the most benefit from it, you should 
move most of your fonts out of your System Folder. This might seem to 
contradict what you've heard about fonts always belonging in the System     

Overview of Suitcase and font management 4-3 

  

Folder, but remember that Suitcase helps you conserve Macintosh memory 
by accessing fonts from outside of the System Folder. 

One way to accomplish this is to create a new folder outside of your System 
Folder, then drag all the fonts (except Chicago, Geneva, and Monaco, which 
the Macintosh OS uses to draw your desktop) out of the Fonts folder in the 
System Folder and into the new folder. Appendix B, “Organizing your fonts,” 
explains more about removing your fonts from your System Folder and 
organizing them in folders on your Macintosh. 

Creating sets easily 

Although it’s not required, another good thing to do before you start creating 
sets in Suitcase is to group the fonts on your Macintosh, as much as possible, 
into folders that reflect the way you think you'll group them in sets in 
Suitcase, This is because you can easily create Suitcase sets by simply 
dragging folders containing fonts into the Suitcase Sets window. 

You can still use and benefit from Suitcase without following this suggestion, 
but since you'll be finding and organizing fonts into Suitcase sets anyway, 
why not first find and organize them all on your hard disk? Then, in addition 
to having your fonts organized and easy to use in Suitcase, you'll also have 
them organized and easy to find on your hard disk. If you choose to do this, 
suggestions for organizing fonts are in Appendix B, “Organizing your fonts.” 

Using drag and drop with Suitcase 

Drag andl drop from the Finder is one way of creating Suitcase sets and 
adding items to them. This feature is available if you are using Macintosh OS 
version 7.5 or later, or System 7 Pro (7.1.1) or System 7.1.2 with the 

Macintosh Drag and Drop extension installed. (The Suitcase installer installs 
this extension.) 

Drag and drop within the Sets window allows you to copy items or even 
entire sets into another set in Suitcase. You can drag and drop in the Sets 

window if you are using Macintosh OS version 7.5 or later, or any version of 
System 7.1.x with the Macintosh Drig and Drop extension installed.
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Figure 4-4 
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2 Find and select an application in the list box. 

3) Click Open. 

A new application set appears. The name is highlighted for you to 
change. 

Adding fonts to sets 
To add fonts to a set, you cam 

a Drag and drop fonts Cor font folders, font suitcases, or sound files) 
onto a set icon in the Sets window 

mw Chick the Add button in the Sets window 

To add fonts to a set using drag and drop: 

1) Select a font (or font folder, Font suitcase, or sound file) you want to 

add to a set. 

The font can be in: 

m ‘The Finder, if you are using Macintosh OS version 7.5 or later, or 

System 7 Pro (7.1.1) or Systent 7.1.2 with the Macintosh Drag and 

Drop extension installed 

e Another set in the Sets window 

mg The Fonts window if the font isa temporary font or a font already 
managed by Suitcase 

2 Pray and drop the font onto a set icon in the Suitcase Sets window 

(Figure 4-5). 

      

The font is added to the set. [f you dragged a folder to the set, two 
things happen: the folder is added to the set and a new, completely 
separate set is created in the Sets window and assigned the same name 
as the folder. 
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To add fonts to a set using the Add button: 

1 In the Suitcase Sets window, select the set you want to add a font to. 

2 Click Add. 

The Add dialog box appears (Figure 4-6). 
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Done     

3° Use the pop-up menu to locate and select the font (or font suitcase, 
or sound Ale) you want to add to the set. 

4 you want te display information about the contents of a font 
suitcase, click Show Contents. 
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disk drive). In this case, you can open these fonts with Suitcase temporarily Figure 4-8 
without placing them in a set. Suitcase closes and forgets about lemporary 
fonts when you shut down or restart your Macintosh. _ _ Mocintosh HD 

—lettylionte ey A220 dF [Ol Eject To open fonts temporarily, you can: Ciseremona DesKlop 
a Drag and drop a font file of a font suitcase from the Finder onto the Cumes fonts 

Suitcase icon (even when Suitcase is open) ES dpen 
  
  a Drag and drop a font file from the Finder into the list of temporary Add Ali 

font files in the Fonts window 

m Choose Add To Temporary from the File menu         ee
 

To open a font temporarily using drag and drop onto the Suitcase 
Open immediately icon:       

1 Inthe Finder, locate the Suitcase icon, 

2 Use the pop-up menu to locate and select the font file or font 
suitcase you want to open temporarily. 

3 Click Add, or, to add all the font or font suitcases shown in the top Suitease 3.0 list, click Add All. 
2 Locate the font file or font suitcase you want to open temporarily The font file or font suitcase is moved to the bottom list. 

d ag ¢ i 2 Suitcase icon, ‘ ind drag and drop it onto the Suitcase icon 4 Click Done. 
Suitcase opens the font file or font suitcase. . . pens (he Suitcase opens the font file or font suitcase. 

To open a font temporarily using drag and drop to the Fonts . 
window: Closing fonts and sets 

1 in the Suitcase Sets window, choose Show Temporary Fonts from the . oo, View menu To close fonts or sets in Suitcase, you can: 

The Fonts window appears with a list of temporary fonts displayed, = Click the Close button in the Sets window 
a Remove them from the Fonts window (this works for temporary 2 Drag and drop the font file or font suitcase you want to open into 

fonts only) the list of temporary fonts in the Fonts window. 

Suitcase opens the font file or font suitcase. To close fonts or sets with the Close button: 

To open a font temporarily by choosing Add To Temporary from the 1 In the Suitcase Sets window, select the open font or set you want to 
File menu: close. 

1 In the Suitcase Sets window, choose Add To Temporary From the File 2 Click Close. 
menu. The bullet in the Open column disappears. 
The Add diwlog box appears (Figure 4-8). To close a temporary font file: 

1 In the Suitcase Sets window, choose Show Temporary Fonts from the 
View menu. 

The Fonts window appears with a list of temporary font files displayed.  
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Figure 4-9 = The Sets window 
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Previewing fonts in the Sample panel 
4 In the Sets window, select a font. 

2 If the Info panel is not open at the bottom of the Sets window, click 
the Info triangle (Figure 4-9). 

A Show button appears in the Info panel (Figure 4-10). 

Figure 4-10 

  

  

  

  
  

  

      

Name Size Kind Dpen Compressed } 

oe BY umes fonts T Ham font set | 

a 280K font suttesse 
DF) Startup Set Sitems startup set . g 

w lato {naa ] (those) (open J 

I Rind: font suitcase 
info panel L : 

Where: Macintosh HDsuitesse doca:Fonts: Times A 

Show 

  

3 Click the Show button to display the Fonts window (Figure 4-11), 

The Fonts window contains a Sample panei, where you can experiment 
with the font by typing text in the preview box and applying different 
styles to it. (See chapter 6, “Menu and Window reference,” for a 
detailed explanation of the Sample panel.)     

Getting information about fonts and sets 4-15 

  

  

NOTE: If a font is inside a font suitcase, choose the font to see a 
sample of it in the Sample panel. 
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Showing font status in the Fonts window 

To display information about a certain category of fonts in the Fonts window, 
choose one of the following from the View menu: 

a Show Open Fonts 

Displays all the open fonts on your Macintosh, including system, 
Suitcase, and temporary font Ales. 

w Show Temporary Fonts 

Displays only the temporary font files on your Macintosh, 

am Show Suitcase Fonts 
Displays only the fonts managed by Suitcase, whether or not they 
ure open. 

a Show System Fonts 
Displays only the fonts found in the Fonts folder of the System 

Foider.



Advanced features 

To enable or disable WYSIWYG Menus: 

1 In Suitcase, choose Preferences from the Edit menu, 

The Preferences dinlog box appears (Figure 5-2). 

Figure 5-2 
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In the Preferences dialog box, click one of the following 

checkboxes: 

a On 

To display Font menus in WYSIWYG format. 

s Off 

To display Font menus normally. 

a Only When Modifier Keys Are Down 

To display Font menus in WYSIWYG format when you press the 
modifier keys checked below (any combination of command, 
option, and control, except that command cannot be used by 

itself), 

Close the Preferences dialog box. 

If you decide you want to reset the Preferences dialog box to its default 
settings, you cin click the Use Defaults button in the Preferences 

window.   

     

Having Suitcase warn you before closing items 

You can specify whether Suitcase requests confirmation before closing items 

in the Sets window. 

To have Suitcase request confirmation before closing Items in the 

Sets window: 
1 

In Suitcase, choose Preferences from the Edit menu. 

The Preferences dialog box appears (Figure 5-2). 

In the Preferences dialog box, click the Warn Before Closing Items 

checkbox. 

Close the Preferences dialog box. 

If you decide you want to reset the Preferences dialog box to its default 
settings, you can click the Use Defaults button in the Preferences 

window. 

Specifying a Hot-Key to open Suitcase 
You can specify whether you want to launch Suitcase with a Hot-Key, which 
is a combination of keystrokes, The preference Hot-Key To Open Suitcase 
Application is turned on by default (command-option-S is the default 

Hot-Key). 

To specify a Hot-Key to open Suitcase: 

1 In Suitcase, choose Preferences from the Edit menu. 

The Preferences dialog box appears (Figure 5-2). 

In the Preferences dialog box, click the Hot-Key to open Suitcase 

application checkbox. 

Enter « Hot-Key combination made up of any combination of the 
following: option, control, command, and an alphanumeric key. 

The only restrictions to Hot-Key selection are these: the period () 
cannot be used, command cannot be used by itself, and any key 
combination that's already used in the Finder menu bar cannot be used. 

The new combination of modifier keys you pressed is shown in the text 

box. 

Close the Preferences dialog box. B
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Compressing files 
To save disk space ancl to make accessing fonts faster, you can use Suitcase 
to compress Ales it manages. In Suitcase, compressed files behave no 
differently than uncompressed files. When you open a compressed file in 
Suitease, the file remains compressed on your hard drive while Suitcase 
relays complete information about the fife lo the requesting application. 

A solid bullet €*) in the Compressed column indicates that the font or set is 
compressed. A hollow bullet (0) indicates that a set contains both 
compressed and uncompressed fonts. No bullet in the Open column 
indicates that the font or set is not compressed, Remember that other people 
who need to access these compressed files must have Suitcase to do so, and 
that other compression programs may not recognize that Suitcase has 
compressed a file. 

  

NOTE: Do not place compressed files in the Fonts folder in your System 
Folder. These fonts are not managed by Suitcase but rather by the Macintosh 

O8, which cannot expand fonts compressed by Suitcase. 
  

To compress a file: 

1 In the Sets window, select the file you want to compress. 

  

NOTE: Suitcase does not compress PostScript printer fonts (it does 

compress PostScript screen fonts). 
  

Fonts must be closed before they can be compressed. 

2 Choose Compress from the Tools menu. 

A bar showing compression progress appears. When the progress bar 
disappears, compression is finished. A bullet (¢) appears in the 
Compressed column next to the compressed file, 

To expand a file: 

1 In the Sets window, select the compressed file you want to expand. 

2 Choose Expand from the Tools menu. 

A bar showing expansion progress appears. When the progress bar 
disappears, expansion is finished. The bullet (#) disappears from the 
Gompressed column after the expanded! file. 

  

    

Creating empty font suitcases 
A font suitcase is a file on your Macintosh in which you can group screen 
fonts and TrueType fonts. 

  

: Bliss 

Macintosh font suitcases provide a convenient way to organize font files, but, 
: more significantly, font suitcases allow the Macintosh OS to treat several fonts 

as a single file. This is an advantage because you can open only a limited 
: number of Macintosh font files at one time. 

3 To find an example of a font suitcase, look inside the Fonts folder in your 
System Folder. Choose By Icon from the View menu, You wil} see lots of little 
suitcases. You can view the contents of a font suitcase by double-clicking it. 

The Create Empty Font Suitcase command enables you to create an empty 

font suitcase quickly and easily for font files you add to your Macintosh. 

To create an empty font suitcase: 

1 Choose Create Empty Font Suitcase from the Tools menu. 

The Directory dialog box appears. 

2 Use the pop-up menu to select a folder to save the font suitcase in. 

3 Optional: change the name of the font suitcase. 

4 Click Save. 

Suitcase creates a font suitcase in the folder you specified. Put the fonts 
of your choice into the new font suitcase. 
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Edit menu 

Close Window 

Closes the front most open window. 

Add To Selected Sets 

Displays a dialog box with which you can choose the item you want to add 
to the set selected in the Sets window. 

Add To Temporary 

Displays a dialog box with which you can choose the item you want to open 
temporarily. Suitcase closes temporary items when you shut down your 
Macintosh. 

Quit 

Quits the Suitcase application. 
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Cut, Copy, Paste, Clear 

Available when dialog boxes appear and when you edit the sample text in 
the font preview box in the Fonts window. 

Select All 

Chooses all elements in a list or text box. 

Remove Selected Items 

Removes selected elements in a list or text box. 

Preferences 

Displays the Preferences dialog box, which you use to set preferences in 

  

  

    

Suitcase. 

View menu 

Figure 6-3 
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Show Info, Hide Info 

Show Info displays the Sets window Info panel, when you are working in the 
Sets window, or the Fonts window Sample panel, when you are working in 
the Fonts window, 

Hide Info hides the Sets window Info panel, when you are working in the 
Sets window, or the Fonts window Sample panel, when you are working in 
the Fonts winclow.
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Show Balloons 

Enables Balloon Help, which displays a descriptive text bailoon when you 
move the cursor over a menu item. 

Overview 

Launches an Overview Guide file that teaches concepts important for 
understanding how to use Suitcase. 

Suitcase Guide 

Launches Suitcase Guide, a comprehensive, task-orlented, information 

system you can use while ninning the Suitcase application. 

Shortcuts 

Launches a Shortcuts Guide that lists the power-user features of Suitcase. 

Sets window 

Suitcase Guide 

The Sets window (Figure 6-6) is where you create and work with your 
Suitcase sets. When you open the Suitcase application, the Sets window 
appears on your Macintosh. If you close the Sets window, you can open it 
again by choosing Show Sets from the View menu. 

Figure 6-6 
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Sets list 

The Sets list is where you view and manage your Suitcase sets, You can sort 
the sets Hist by clicking on one of the five column headings: 

Name 

Identifies the name of each set and item in Suitcase. 

  

NOTE: Very long names are displayed in truncated form; to view the 
complete name just enlarge the Sets window. 
  

Size 

Determines the number of items in each set and the size, in kilobytes, of 

each item in a set. 

Kind 

Indicates whether the selected item is a Startup Set, font set, application set, 
font, font suitcase, sound, or alias. 

Open 

Signifies whether a set or item is open or closed. If an item or all items in a 
set are open, a bullet (¢) is shown in this column. If some items in a set are 
open and some are closed, a hoflow bullet (o) is shown. If aé/ items in a set 
are closed, the open column is empty. A yellow warning icon in this column 

: designates an item or a set containing items that were not opened because 
: fonts with the same name are already open on your Macintosh, 

Compressed 

Signifies whether or not an item or set is compressed. If aff items in a set are 
compressed, a bullet (*) is shown, If some items in a set are compressed and 
some are not compressed, a hollow bullet (co) is shown. if #0 items in a set 
are compressed, the open column is empty.  
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Fonts window 

Figure 6-8 
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Figure 6-9 

  

© open fonts 
  

temporary fonts 
Suitcase fonts 
system fonts     
  

a = Open fonts 
Lists all open fonts on your Macintosh, including fonts in the Fonts 
folder in your System Folder, fonts that Suitcase manages, and 
temporary font files, 

a = Temporary fonts 
Lists all fonts opened by Suitcase on a temporary basis. 

m= Suitcase fonts 

Lists all fonts that Suitcase manages, whether or not they are open. 

e System fonts 
Lists all fonts found in the Fonts folder in the System Folder on your 
Macintosh. 

The Fonts list is where you view information on Suitcase fonts. You can sort 
the Fonts list by clicking on one of the column headings:     
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Name 

Identifies the name of the font. 

Kind 

Determines the category into which a font falls. 

Location 

Specifies the location of a font file. 

Fonts window Sample panel 

Sample panel 

  

Figure 6-10 
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Font Preview box 

Previews what a particular font looks like. You can type your own text in this 

box. 

Size text box 

Specifies the size (between 6 and 72 points) of the sample text in the font 
preview box. 

Normal, Condensed, and Extended radio buttons 

Specify the spread of the sample text in the font preview box.
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You can add these objects to an application or font set: 

= File 

« §=Font file 

m Font suitcase 

® Sound file 

s Font set 

You can open, close or delete these objects: 

wu File 

a Font file 

ma Font suitcase 

® Sound file 

a =Font set 

ms Application set 

You can count or use exists with these objects: 

» File 

« =§6 Font Ale 

mw Font suitcase 

ma Sound file 

» Font set 

s Application set 

a Window 

You can get properties of these objects: 

a File 

ma Font file 

ma Font suitcase 

m Sound file 

a Font set 

a Application set 

a §=Window       

You can set these object attributes: 

wn File 

# Font file 

= Sound file 

a Application set 

m Font set 

x Window 

You can refresh displays. 

Displaying the AppleScript dictionary for Suitcase 
Here's how to list brief descriptions of the AppleScript objects and verbs you 
can use to automate routine and repetitive Suitcase tasks. 

  

NOTE: You need Script Editor, which Apple provides with AppleScript, (or 
another script editor) to perform these steps. 
  

To display the AppleScript dictionary for Suitcase: 

1 Launch the Apple Script Editor application. 

2 Choose Open Dictionary from the File menu. 
The Directory dialog box appears. 

3 Use the pop-up menu to find and select the Suitcase application. 

4 Click Open. 
The AppleScript dictionary for Suitcase appears. 

5 Click the suite or suites about which you want information. 
When you’re done, choose Quit from the File menu. 

AppleScript reference books 

The following books contain information about using AppleScript: 

The Tao of AppleScript by Derrick Schneider (Hayden Books, 1994. ISBN 

1-56830-115-4.) 

Danny Goodinan's AppleScript Handbook by Danny Goodman (Random 
House, 1994. ISBN 0-679-75806-2.)



  

  

  

  

  

  

Troubleshooting 

If the Suitcuse extension is missing from the Extensions folder of your System 
disk, reinstall Suitcase. 

However, if the Suitcase extension is present in the Extensions folder, then a 

conflict may exist. Isolate the Suitcase extension by opening it as the only 
extension on your Macintosh. If it works, there is probably a conflict with 
another extension. 

To resolve extension conflicts, you can first try: 

mn Replacing any old, out-of-date extensions. 

a Changing the order in which your extensions load by changing their 
names. For example, rename Suitcase Extension to AASuitcase 
Extension so it will joad first. 

If you still cannot resolve the conflict, you need to determine which 
extension is causing the conflict: 

1 Open the System Folder on your startup disk and create two new 
folders: Extensions Off and Control Panels Off. 

2 Drag recently added items (other than Suitcase) from your 
Extensions folder to the Extensions Off folder, and from your Control 
-anels folder to the Control Panels Off folder. 

3 Restart your Macintosh. 

4 If the Suilcase extension still doesn’t load, disable more extensions 
hy moving them from Extensions to Extensions Off and restart. 
Continue this until the Suitcase extension loads at startup. 

5 When the Suitcase extension loads at startup, move two or three 

items atatime back to the Extensions folder, restarting each time 

until you isolate the troublesome extension. 

A font in an application set does not appear in the Fonts menu 

Ifa font you add to an application set is not in the Fonts menu when you 
launch the application: 

1 Confirm that the font is inclided in the application set. 

If itis not, add itand relaunch the application. 

2 ff the font stif! does not appear in the Font menu, confirm that the 

font is open. 

To see which fonts are open, in Suitcase, open the Fonts window and 
choose Open from the pop-up menu. 

If the font isn’t open, open it and relaunch the application. 

eB 
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3 if the font still does not appear, drag the application’s Preferences 
file to the trash and relaunch the application. 

4 If the font still does not appear, create a new application set for the 
application. 

See chapter 4, “Managing your fonts,” for information. 

5 Move everything in the old application set into the new application 
set. 

6 Find and make a note of any other sets that contain the old 
application set. 

Delete the old application set. 

8 Add the new application set to the sets you noted in step 6. 

9 Relaunch the application. 

A font oP ears in the fonts menu even after you remove it from the 
Fonts folder 

If a font keeps appearing in the fonts menu and the font is not Chicago, 
Geneva, or Monaco (supplied by the System Foldez): 

1 Search your Macintosh, including all font suitcases and folders, for 

the font file. 

2 Drag all copies of the font file you find to the Trash. 

PostScript fonts you add to your Macintosh do not display or print 
correctly 

if the PostScript fonts you add to your Macintosh are not working correctly or 
causing your Macintosh to crash: 

1 Do you have a copy of the PostScript fonts on disk? 

if yes, try reinstalling the font from a master disk or a backup. 

IF no, go to the next step. 

2 Do you have QuickDraw GX installed on your Macintosh? 

If yes, convert the PostScript fonts to QuickDraw GX fonts with the 
Type 1 converter. 

If no, go to the next step.
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Organizing your fonts 

Ways to organize your fonts 
The number of ways to organize fonts is as great as the number of Macintosh 
users. You might organize fonts alphabetically, by client, job, or appearance. 
Fonts can be organized into serif, sans serif, decorative, script, headline, or 
body text categories, 

This chapter offers you several ways of organizing fonts on your hard drive, 
and then using this organization to create and use sets in the Suitcase 
application. 

Three possible ways to organize your fonts are: 

a Alphabetically 

= By client or job 

m By family 

These suggestions all include the same premise: removing font files from 
their original locations (including the My Fonts folder as explained above, or 
the Fonts folder in the System Folder), placing them into separate folders on 
your Macintosh and then placing them in Suitcase sets where you can control 
them. 

  

NOTE: We do not recommend removing fonts required to label Macintosh 
windows and menus from the Fonts folder in the System Folder. These 
include Chicago, Geneva, and Monaco. 
  

Organizing fonts alphabetically 

One basic way to organize fonts into sets is alphabetically: 

To organize fonts alphabetically on your Macintosh: 

1 Locate the fonts you want to use on your hard drive, or on a remote 
drive, 

Create five new folders with the names A-E, F-J, K-O, P-T, and U-Z. 

Place font files and font suitcases into the correct alphabetized 
folders. 

To organize fonts alphabetically in Suitcase (Macintosh OS version 7.1.1, 
7.1.2, or 7.5 or later): 

1) Launch Suitcase.     
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2 Drag and drop the folders of fonts A-E, F-J, K-O, P-T, and U-Z onto 
the Sets window from the Finder. Suitcase creates font sets for exch 
of the folders that are assigned the same name as the original folder 
(Figure B-1), 

Figure B-1 
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To organize fonts alphabetically in Suitcase {System 7.1.0): 

1 Launch Suitcase. 

2 Create a new font set for A-E, F-J, K-O, P-T, and U-Z, 

3 Use the Add button to add all the members of the alphabetized 
folders you created above to their respective sets in Suitcase 
(Figure B-1). 

Organizing fonts by client or job 

If you are a service bureau, designer, or graphic arts professional you may 
already organize at least some of your fonts by client or job, so the task of 
organizing your fonts in Suitcase by client or job is made all the easier. 

To organize fonts on your Macintosh by client or job: 

1 Locate the fonts you want to use on your hard drive, or on a remote 
drive. 

2 Create a new folder on your Macintosh for each client or job which 
has a group of associated fonts. 

3 Place font files and font suitcases into the correct client or job 
folders.
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Knowing some basic font history, terminology, and concepts can help you 
get the greatest possible benefits from Suitcase and from your fonts. 
Contained in this appendix are; 

u A brief history of printing and typesetting 

m A discussion of common printing and typesetting terms 

= Information on how to use fonts effectively and where to get them 

= An explanation of Macintosh font concepts 

A brief history of printing and typesetting 
Many of the desktop publishing terms and concepts we use today have their 
origins in traditional printing and typesetting. In the West, printing began 
when German printer Johann Gutenberg first demonstrated a movabie-type 
printing press in the fifteenth century. 

in Gutenberg’s press, each character was embossed on a metal block called a 
body. The embossed area was called a face, which is the source of the term 
typeface. Printers arranged type and spaces in trays to create lines, and 
assembled these lines into pages by placing them in a framing box. The 
assembled type was inked and paper pressed to it to create printed pages. 

The same basic methods were used until the nineteenth century, when 
printing, like most other manufacturing processes, became automated. After 
World War I, mechanical printing technology was supplemented by 
photographic technologies. In the early 1960s, computerized processes that 
converted images into electrical signals began to be used in printing. 

Today, laser printers and computers are widely used for printing. When a 
page is sent to @ printer, the computer first translates the images on the page 
into instructions that the printer can understand. Once the printer interprets 
the page, a laser beam inside the printer creates an electrical image of the 
page on a rotating drum. Because the drum has an electrical charge, it can 
pick up toner (fine particles containing an electrical charge opposite to that 
of the drum) with the image of the page. The toner is heated and fused onto 
paper as it rolls past the drum, creating a printed page.
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Common printing and typesetting terms 

Printers and typesetters have a large vocabulary of specialized terms related 
to their work. A few of the more common terms associated with fonts and 
desktop publishing are explained in this section, 

Character set 

The complete collection of printable characters fora given font, including 
letters, numbers, and punctuation. A character set can also include special 
international language characters, mathematical symbols, and symbols like @. 
(You type some special characters by pressing a combination of keys.) 

Typeface 

A complete set of characters in varying sizes. For example, all the available 
sizes of Times Regular make up a typeface. 

Style 

A design variation of a typeface, such as Times Regular, Times Italic, Times 

Bold, or Times Bold Itatic. 

Typeface Family 

Used to describe all the styles of a typeface, such as the Times family shown 
above, 

Font 

‘Traditionally refers to a complete set of characters in a single size, style, and 
weight, such as Times Regular 12 point. Today, however, the terms font and 
typeface are often used interchangeably. 

Script 

Any typeface designed to imitate hand-written text, such as Zapf Chancery. 

Display 

Any typeface designed to be displayed at larger sizes as when used for signs, 

headlines, or graphics rather than for body copy. 
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Pi, or Dingbats 

Any typeface made up of special characters, such as Zapf Dingbats (also 

called a symbol typeface). 

Serif and sans serif 

A serif is a decorative line at the tips of the major strokes of a letter. An 
example of a serif typeface is Times. Sans serif literally means “without 
serifs.” An example of a sans serif typeface is Helvetica. 

Condensed and narrow 

A typeface style designed to take up less horizontal space on a line. A 
condensed typeface is proportionally scaled throughout, while a narrow 
typeface can be scaled in some places and not in others. 

Italic and oblique 

Italic is a slanted typeface style, like Tinres Regular Italic. An oblique typeface 
has the same effect, but is slanted mathematically by the computer rather 
than having each letter individually designed. Originally created to imitate 
handwriting, today italic or oblique type is used to provide emphasis or 

othenvise differentiate text. 

Weight 

Refers to the width of the lines making up a character. Most Typeface 
Families include a bold and a regular style, and some include a light style as 
well. Bold type js usually used to give selected text more emphasis than the 

text surrounding it. 

Point Size 

Originally referred to the physical height of an individual piece of metal type. . 
‘Today this term refers to the height of a typeface on paper. Point size, like 

other type characteristics, is adjusted for legibility. 

Pitch 

The number of characters in a typeface that can fit into an inch (also called 

CPI; characters per inch, or CPP: characters per pica}.
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Points and Picas 

Typographer’s measurement system based on 72 points to the inch. There 
are 12 points to a pica. 

Mono- and Proportional Spacing 

Monospace characterizes a typeface like Courier, in which each character 
takes up the same amount of horizontal space. Originally designed for 
typewriters, monospaced typefaces often have an old-fashioned appearance, 
but they are useful for presenting data in columns. 

In a proportionally spaced typeface, like the one you are reading now, letters 

iike “?’ take up less horizontal space than wide letters like “w,” Proportionally 
spaced type takes up less room on the page and is easier to read. 

Leading 

The amount of vertical space between lines of text Calso called linespacing). 
This space is adjusted to increase legibility depending on which typeface is 
used and how wide the column of text is. 

Letterspacing 

The space between individual letters. Increase or decrease letterspacing to 
increase legibility or to achieve a certain design effect. There are two ways to 
decrease letterspacing: tracking decreases the space between all letters 
equally, and kerning decreases space between individual letters. 

  

NOTE: See your word-processing or page-layout program's documentation 

for information on how to manipulate the type characteristics explained in 
this section. 
  

Using fonts effectively 

Choosing fonts for a document is an important design decision because fonts 
greatly influence the message of a document and how well. it transmits that 
message to readers. It would take an entire book to adequately cover this 
topic (and many good books have been written about this) but if you are 
new to font selection, there are a few traditional guidelines you can follow to 
make sure all of your documents took their best:     

m Serif typefaces, like the one you are reading now, are usually 
considered the best choice for the body of the text, because the 
serifs are designed to lead the eye from one word to the next. 

= Sans Serif typefaces, like Helvetica, are traditionally used for tides, 
headings, and signs, because the clean look of sans serif type, in 
short phrases, is bold and attention-getting. (Traffic signs, for 
instance, are printed in sans serif type.) 

m Mixed case letters Cagain, like the ones you are reading now) are the 
best choice for body copy, because ALL CAPITAL LETTERS BECOME 

MONOTONOUS AND DIFFICULT TO READ AFTER A WHILE. 

Lower-case letters have more widely varying shapes, and are more 
quickly recognizable. Capital letters, which are all basically 
rectangular-shaped, are harder for the eye to differentiate. 

ms Two typefaces are usually all you need in a single document. Unless 
designed by a professional graphic artist, more than this can make a 
document confusing and unfocused. 

m = Italic and boid text should be used consistently and sparingly to 
make things stand out. If everything is bold or italic, nothing stands 
out. 

= Point sizes below 8 are difficult for some people to read. Also, 
creating wide columns of text in a smail point size is not a good 
idea; nor is using a point size so large that only a few words can fit 
on a line. 

= The style of type will affect the tone of a document. While a 
traditional font like Times or Palatino can be used appropriately for 
almost any document, a “fun” or unusual font conveys a casual tone, 
which may not be appropriate for serious communication. 

Of course, these are just recommendations based on tradition and readability 
data. There are many publications that break typography “roles” to achieve 
very effective layouts: this is because they were carefully planned by graphic 
artists to create a specific effect for a particular audience. 

Where to get fonts 

Retail fonts’ 

One way to obtain fonts is to select them from catalogues provided by type 
manufacturers. Adobe Systems, for example, publishes a quarterly catalog of 
its font library.
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You can find the names and phone numbers of font publishers by looking 
for their ads in computer publications, You can also find information about 
font publishers through on-line services such as Compuserve, America 
Online, Prodigy, and eWorld, or by surfing the Internet. 

Shareware and freeware fonts 

In addition to retail font publishers, many fonts exist in the public domain as 
freeware and shareware. Freeware can be distributed and used freely. 
Shareware is distributed freely (or under a few guidelines) but if you decide 
to keep it you must pay the author a (usually smallf} fee. 

You can get shareware and freeware fonts from on-line services, bulletin 
board systems and the Internet. Compuserve, America Online, Prodigy, and 
eWorld all feature areas devoted to fonts and typography. If you download 
fonts from these services, please be sure that they are Macintosh compatible 
and free of viruses. 

  

  

NOTE: Shareware and freeware fonts sometimes do not include complete 
character sets: they may be missing international language characters, 
punctuation or other special symbols, or may include only capital or lower 
case letters and numbers. 
  

An explanation of Macintosh font concepts 

This section discusses the following Macintosh font concepts: 

m Macintosh font suitcases 

a Bitmap fonts 

= PostScript fonts 

. TrueType fonts 

x QuickDraw GX fonts 

How the Macintosh OS organizes and manages fonts 

Under System 7.1 and later versions of the Macintosh OS, all fonts are stored 
in the Fonts folder in the System Folder. When the Fonts folder is inside an 
active System Folder, it has a large A on it. 
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Apple created the Fonts folder to organize all Macintosh fonts in one place, 
keep fonts from cluttering the System file and Extensions folder, and allow 
you to add fonts to your Macintosh while applications are open. 

However, those fonts won't be available to applications until you relaunch 
them. In addition, you cannot remove fonts from the Fonts folder while any 
applications are open on your Macintosh. Another important limitation is that 
the Fonts foider allows you to open no more than 128 font suitcases at a 
time. 

Suitcase overcomes all of these limitations, and adds the ability to selectively 
open specific groups of fonts Cont sets) which you can create based on your 
needs. 

To use fonts in Suitcase, you should remove them from your Fonts folder, 
place them in a folder on your hard drive and start adding them to Suitcase 

sets. By removing fonts from the System Folder and managing them with 
Suitcase, you can get the most benefit from the organizational and memory 
saving capabilities of Suitcase. 

About Macintosh font suitcases 

Macintosh font suitcases 

A font suitease is a file on your Macintosh that groups screen fonts, TrueType 
fonts, and GX fonts. You can view the contents of a font suitcase by double- 
clicking it. Macintosh font suitcases provide a convenient way to organize 
font files, but, more significantly, font suitcases allow the Macintosh OS to 

treat several fonts as a single file. 

To find an example of a font suitcase, look inside the Fonts folder in your 
System Folder. Choose By Icon from the View menu. You will see lots of little 
suitcases, 

The icon for a font suitcase looks like this: 

oer 

A | 
Bliss 

    NOTE: Keep in mind that “Suitcase” and “suitcase” are two different things: 
suitcase Cowercase) is a file that stores screen (bitmapped) fonts. Suitcase 
(with a capital S) is the Symantec product. 
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Bitmap fonts 

Bitmap technology creates characters by arranging a series of individual 
pixels (dots) into the shape of the character using either light pixels (when 
the font is displayed on a monitor) or ink pixels (when the font is printed on 
paper). 

An example of a bitmap font (also called a screen font) is any of the original 
ten city fonts included on the Macintosh, such as London, Los Angeles, or 

San Francisco, Bitmap fonts are also called screen fonts, because they were 
designed to be visible on the original Macintosh 72 DPI monitor, and to print 
well on the original low-resolution DPI Image Writer. 

Bitmap fonts are measured in pixels, so a 72-point bitmap letter is 72 pixels 

high. 

Disadvantages of bitmap fonts 

Bitmap fonts come in a few standard point sizes. When you select a non- 
standard point size, your Macintosh resizes the font as well as it can. This 
resizing can result in a jagged-looking font, especially when you print them 
at larger point sizes. 

Another disadvantage of bitmapped fonts is that they tend to use up a lot of 
RAM and space on your hard drive. 

Where to keep bitmap fonts 

Bitmap fonts are stored in separate files (one point size per file), which can 
be grouped inside a font suitcase. 

The fonts Chicago, Geneva, and Monaco also are kept in Read Only Memory 
(ROM) in your Macintosh. This is because the Finder needs something to 
display text in windows and clialog boxes when you restart your Macintosh 
with extensions off, or if you shouid inadvertently remove the Fonts folder 
from the System Folder. 

PostScript fonts 

PostScript is a page-description language developed by Adobe Systems that 
applications use to describe text and graphics to PostScript printers. In 
PostScript, a character is described to the printer in mathematical formulas as 
a series of lines and curves with filled or empty areas.   

  
    

o 

  

An explanation of Macintosh font concepts C-9 

  

The release of PostScript allowed users to print high resolution, 300 DPI 
characters on their PostScript printers instead of being limited to the 72 DPI 

characters they were used to seeing displayed on their screens. 

Since fonts could still only be displayed on screen at 72 DP], Adobe created 
two files for every font: one for the screen and another for the printer. 
QuickDraw (the built-in software technology your Macintosh uses to draw 
images on your screen) uses the information in the screen font file to display 
the font on your screen, while PostScript uses the information in the printer 

fent file to print with a resolution your printer supports. 

Screen font files are also called QuickDraw, display, and fixed-size fonts. 
Printer font files are also called outline fonts. 

A screen font file icon looks like this: 

Times 10 

PostScript printer font file icons can look different, depending on where you 
got the font. Here are two examples: 

  

va, aay 

LetteGot 
      

  

Do not change the name of a PostScript printer font file. Your Macintosh will 
not be able to find the fle when you print, and will substitute another font, 
usually Courier. 
  

Advantages of PostScript fonts 

Besides allowing fonts to be printed at higher resolutions, PostScript also 

allows fonts to be resized or scaled. Text looks just as smooth at 72 points as 
it does at 6 points. PostScript fonts print faster and take up less space on your 

disk than TrueType fonts (see below) and they cause fewer problems with 
PostSeript printers than TrueType fonts.



C-10 Font Companion 

  

Where to keep PostScript fonts 

PostScript screen fonis are usually kept in font suitcases (see definition 
above) in the Fonts folder of the System Folder. PostScript printer font files 
also are kept in the Fonts folder in your System Folder. 

To have Suitcase manage your PostScript fonts, however, you should remove 
beth the screen fonts and their corresponding printer fonts from the Fonts 
folder, place them in a folder on your hard drive and start adding them to 
Suitcase sets. By removing fonts from the Fonts folder and managing them 
with Suitcase, you can get the most benefit from the organizational and 

memory saving capabilities of Suitcase. 

  

NOTE: If you lose a screen or printer font, you need to replace it. If a screen 
font is lost, that font does not appear correctly on your screen. Likewise, if a 
printer font is lost (even if you still have the screen font) the font will be 
replaced when you try to print it (usually with Courier). 
  

Adobe Type Manager and PostScript fonts 

ATM is a system extension that renders PostScript printer fonts on your 
screen for sizes that you don’t have installed, and lets you print PostScript 
fonts on QuickDraw (and other non-PostScript) printers. You will still need at 
least one screen font for each PostScript font, because the Macintosh OS 
needs it to know the font exists and to display it in application font menus. 

Printer-resident PostScript fonts 

Most PostScript printers come with some fonts in Read Only Memory (ROM), 
called resident fonts. The Apple LaserWriter and most other PostScript 
printers store the following fonts in ROM: 

mw ITC Avant Garde Gothic 

e ITC Bookman 

a Courier 

a Helvetica 

mw New Century Schoolbook 

gs Palatino 

w Symbol 

s Times     
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a ITC Zapf Chancery 

u ITC Zapf Dingbats 

Downloading PostScript fonts 

If your document contains a PostScript printer font that is not already stored 
in the ROM of your laser printer, your Macintosh automatically sends the font 
to the laser printer. 

Once downloaded, the font remains in the Random Access Memory (RAM) of 

your laser printer and is available to use until you either reset your printer or 
turn the printer off. 

TrueType fonts 

Incorporated into version 7.0 and later versions of the Macintosh OS, Appie 
and Microsoft developed TrueType in response to high licensing fees for 
PostScript. Like PostScript, TrueType is an outline font technology that 
produces smooth, scalable fonts at any resolution. Unlike PostScript, 
TrueType puts screen and printer font information into a single font file. 
(Another difference is that while TrueType is only a font technology, 
PostScript is both a font and a graphics technology.) 

A TrueType font file icon looks like this: 

Arial 

  

NOTE: Although TrueType provides both screen and printer font 
information, you may still see screen fonts mixed with your TrueType fonts 
in font suitcases. This is because some suppliers of TrueType fonts also 
include a screen font, because the Macintosh displays screen fonts slightly 
faster than TrueType fonts. However, the increase in speed is minimal, and 
you can safely remove the screen fonts from the font suitcase. 
  

Advantages of TrueType Fonts 

In addition to creating smooth, scalable fonts on screen, TrueType fonts can 
be printed on QuickDraw or other non-PostScript printers. This is an 
advantage because PostScript printers typically cost several hundred dollars
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more than non-PostScript printers. Also, TrueType supports non-Latin 

character sets such as those used in Japanese, Chinese, and Korean. 

Where to keep TrueType fonts 

Usually, TrueType fonts are kept in font suitcases in the Fonts folder in the 
System Folder, 

To use TrueType fonts in Suitcase, you should remove them from your Fonts 

folder (except Chicago, Geneva, and Monaco which are used by the System), 

place them in a folder on your hard drive and start adding them to Suitcase 
sets. By removing fonts from the Fonts folder and managing them with 
Suitcase, you can get the most benefit from the organizational and memory 
saving capabilities of Suitcase. 

Should you use PostScript or TrueType fonts? 

The answer depends on where your documents are output. 

If you print your documents on a QuickDraw printer only, all you need are 
TrueType fonts, but you can use Adobe Type Manager and PostScript fonts if 
you want to. 

  

NOTE: You can keep identical TrueType and PostScript fonts on your 
Macintosh as long as each is assigned a unique name (duplicate font names 
on your Macintosh can cause conflicts). Sending TrueType fonts to 4 printer 
containing resident PostScript fonts with the same name also can cause 
problems. To find out which PostScript fonts are stored on your laser printer, 
check printer documentation or use the LaserWriter Font Utility from Apple. 
You can also uncheck Font Substitution in the Page Setup dialog before 
printing documents Cif you leave the box checked, the printer substitutes 
printer-resident fonts for TrueType fonts in the document}. 
  

If you have a PostScript printer, you can use either TrueType fonts or Adobe 
Type Manager and PostScript fonts, but if you are creating high-end 
documents and have access to a PostScript printer, use Adobe Type Manager 
and PostScript fonts to take advantage of its capabilities. 

If you regularly send your documents to a service bureau to be printed, it is 
a good idea to use only PostScript fonts (unless the bureau tells you 
TrueType fonts are acceptable) because most service bureaus use only 
PostScript devices. TrueType fonts used in documents may be replaced by 
PostScript and your document might not look like you expect them to.   
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Service bureaus allowing TrueType may request that you supply a disk 
containing all of the fonts you require so they can print your document 
exactly as you intended. Many also use Suitcase, which also helps ensure that 
the document they print for you comes back the way you expected, 

Using TrueType and PostScript fonts in the same document 

Using both PostScript and TrueType in the same document is nota 
problem if: 

m You have Adobe Type Manager installed on your Macintosh and you 
print your document on a non-PostScript printer. 

w= You don’t mind that your PostScript printer substitutes printer- 
resident fonts for the TrueType fonts in your document (which may 
change the way your document looks), 

® You are not sending your document to a service bureau (or the 

service bureau you use can work with TrueType fonts). 

QuickDraw GX fonts 

With System 7.1 Pro, Apple introduced QuickDraw GX, a new version of 
QuickDraw that extends the capabilities of the Macintosh OS. QuickDraw GX 
introduces yet another type of font: the QuickDraw GX font. 

You install and use QuickDraw GX fonts the same way you do TrueType 
fonts. QuickDraw GX fonts even use the same icon as TrueType fonts. 

Advantages of QuickDraw GX fonts 

QuickDraw GX is an entire imaging system, not just a font technology. It 
adds advanced printing and typographical functions to the Macintosh OS. 

Using PostScript fonts under QuickDraw GX 

With QuickDraw GX, you need to convert your current Type 1 PostScript 
fonts to the GX storage format using the QuickDraw GX Type 1 Enabler, This 
conversion allows you to install Type 1 PostScript screen and printer fonts as 
easily as you install TrueType fonts: drag a single font file onto the System 
Folder. 

If you still use Type 3 PostScript fonts, you’ll need to first use a font- 
conversion utility (there are several available) to convert them to Type 1, and 
then convert them to the GX storage format, before using them with 
QuickDraw GX. Another alternative is to contact your font vendor and find 
out if a Type 1 or GX version of your Type 3 font is available.
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You also need to use Adobe Type Manager GX instead of Adobe Type 
Manager. ATM GX comes with the QuickDraw GX software. 

    

      

  

Glossary 

alias An icon in the Finder that, when double-clicked, opens the file, 

folder, application, or disk linked to it. Aliases were introduced 
in Macintosh OS version 7.0. 

In Suitcase, any font set that you put into another set, (excluding 
application sets and the Startup Set, which you cannot place into 
other sets) operates as an alias. When you delete an alias of a 
font set in Suitcase, the actual set to which it refers remains 

unchanged, However, if you delete the original font set in 
Suitcase, all aliases of the set are deleted as well. 

application A computer program written for a specific purpose, such as 

word processing or creating a spreadsheet. Also called a 
program or an application program. 

application set A type of set managed by Suitcase that allows you to open a 
group of fonts whenever you launch the application to which 
they are linked. 

bitmapped font A type of font that your Macintosh displays as a specific 
arrangement of pixels, or dots, on your screen, A bitmapped 
font is also called a screen font. 

button See radio button and user button. 

character A single alphanumeric character you press on your keyboard 
that appears on your screen or is printed on your printer. 

desk accessory A “mini-application” that is available from the Apple menu 
regardless of which application you are currently using, 

desktop The Finder; or, the working area you see below the menu bar at 
the top of your screen when you are using your Macintosh. 

diaiog box A window that appears on your screen, containing buttons, 
checkboxes, and other elements. 

double-click You double-click an element on your screen when you move 
the cursor over the element and press the mouse button twice 
quickly.
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drag and drop 

drive 

extension 

Finder 

font file 

font ID 

font ID conflict 

A feature added to Macintosh OS version 7.1, Suitcase supports 
drag and drop from the Finder if you are using one of the 
following: 
= Macintosh OS version 7.5 (or later) 
m System 7 Pro (7.1.1) or System 7.1.2 with the Macintosh Drag 

and Drop extension Cinstalled by Suitcase) 

A storage device. There are primarily two types: floppy disk and 
hard drive. A drive is sometimes called a disk or volume. 

See system extension. 

The Finder is the part of the Macintosh OS that regulates 
functions such as the copying, renaming, and deleting of files on 
your Macintosh. The Finder is often also called the desktop. 

See also desktop. 

A file that contains a particular font. Types of font files include 
screen font files (also called bitmapped font files), PostScript 
font files Gwhich include screen font files and corresponding 
printer font files or outline fonts), and TrueType font files. 

A TrueType font file icon looks like this: 

=
 

Arial 

A PostScript screen font fle icon looks like this: 

(A 
Times 10 

PostScript printer font file icons can look different, depending 
on where you got the font. Here are two examples: 

= 
  

  

IN 

    LetteGot   

A number that uniquely identifies every font on your Macintosh. 

Happens when an application associates a font with an ID 

number that’s different from the ID number used by the 
application that created the document, (Usually this happens   

    

font ID file 

font name conflict 

font set 

font suitcase 

hinting 

Hot-Key 

icon 

kern 

with older applications that still wack fonts by ID number; most 
applications sold today track fonts by name.) Font iD conflicts 
can cause fonts to display or print incorrectly after you transfer a 
document to another Macintosh, even if the fonts appeared on 
and printed from your Macintosh correctly. 

A file that contains a list of every font and its corresponding 
identification number on your Macintosh, 

A font name conflict occurs when two or more fonts are 
assigned the same name by the Macintosh OS. 

See set. 

A file on your Macintosh that groups screen fonts, TrueType 
fonts, and GX fonts. You can view the contents of a Font suitcase 

by double-clicking it. Macintosh font suitcases provide a 
convenient way to organize font files, but, more significantly, 
font suitcases allow the Macintosh OS to treat several fonts as a 
single file. 

The icon for a font suitcase looks like this: 

A | 
Bliss 

A software technology that enhances the sharpness and clarity of 
a font when it is printed at smaller point sizes on low-resolution 
printers, 

A special combination of keys you press to perform an 
automated operation. 

Pressing the Hot-Key command-option-K at any time for 
example, launches Suitcase. You can change the Hot-Key that 
launches Suitcase in the Suitcase Preferences window, 

A graphic symbol used to represent a file, folder, drive, or other 
element. 

To kern characters is to adjust or change the spacing between 
two, adjacent characters so that they look more proportionally 
balanced and read more easily. Capital letters followed by lower 
case letters, like T and o for example, are often kerned to 

produce more space within a line of text. 
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launch 

linked 

modifier key 

point 

pop-up menu 

PostScript 

Power Macintosh 

PRAM 

printer font 

QuickDraw 

QuickDraw GX 

To launch an application is to open it, usually by double-clicking 
its icon in the Finder. 

Fonts that Suitcase opens when you launch an application are 
said to be linked to that application. 

A key you can press on your keyboard or keypad in sequence 
with an alphanumeric character to execute a command instead 
of displaying the character on your screen. Standard modifier 
keys include caps lock, shift, control and option. 

In desktop publishing typography, a measurement equal to '/,,.. 

A menu that appears in dialog boxes and windows, usually 
identified by a triangle that points downward. When you click. 
the triangle, the menu usually drops down to display the options 

- you can select. 

A computer language that tells your printer how to print a 
document page shown on your computer screen. PostScript was 

developed and is licensed by Adobe Systems. 

See also QuickDraw. 

A series of Macintosh models equipped with a PowerPC 
microprocessor chip. ‘ 

PRAM, which stands for Parameter Random Access Memory, is a 

memory chip in your Macintosh in which settings such as the 
time and the tracking speed of your mouse are permanently 
stored, even after you turn off your computer. The PRAM 
memory chip is powered by a small internal battery. 

A type of PostScript font that your printer uses to print a screen 
font on your printer. Printer fonts are also called outline fonts. 

The underlying, built-in graphics and drawing software 
technology on your Macintosh that displays text and graphics on _ 
the screen. a 

An optional, underlying, built-in graphics and drawing software 
technology, released with Macintosh OS version 7.5, that 
augments the drawing, printing, and typographical features of 
the Macintosh OS. 

  

radio button 

reboot 

remote fonts 

removable media 

restart 

sans serif 

screen font 

script 

serif 

set 

A round button shown on dialog boxes and windows that 
enables you to select one option from a set of mutually 
exclusive options. 

See restart. 

Fonts that are stored on a server in a network. 

Drives that you can remove, as opposed to hard drives that you 
cannot remove except by dismantling their housing. Examples of 
removable media include floppy disks, cartridges such as 
SyQuest and Bernoulli, and compact disks. 

To restart your Macintosh is to start your Macintosh again. You 

can restart by choosing Restart from the Special menu in the 
Finder, or by turning your Macintosh on after you have shut it 
down. Restarting is also called rebooting. 

A typeface without serifs. An example of a sans serif typeface is 
Helvetica. 

See also serif. 

A type of PostScript font that your. Macintosh displays as a 
specific arrangement of pixels, or dots, on your screen. A screen 
font is also called a bitmapped font. 

A.set of procedures you specify that automate a routine task or 
repetitive operation on your Macintosh. 

A fine line or stroke at the tips of the major strokes of a letter. An 
example of a serif typeface is Times. 

A list or grouping of fonts in Suitcase. Types of sets include: 

Font set, which you can open and close when necessary. 

Application set, which contain fonts that Suitcase opens when » 
you launch the application to which they are linked. 

Startup Set, which contains fonts that open whenever you start 

your Macintosh. Fonts in the Startup Set remain open until you 

close them. 

When you remove or delete a font from a set or from Suitcase, 
the actual font is left unaltered.
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shut down 

sound file 

startup 

startup drive 

Startup Set 

Suitcase 

suitcase font 

system extension 

System Folder 

system font 

TrueType 

Type 1 font 

typeface 

To shut down your Macintosh is to turn off your Macintosh or : 
prepare jt to be turned off. 

A file containing digitized sound. 

The process by which your computers starts working. During 
this process, system extensions such as the Suitcase extension 
are loaded into memory. 

A drive (your hard drive or a floppy disk) with all the necessary 
program files—such as the Finder and System files contained in 
the System Foider—that sets your Macintosh into operation. The 
startup drive is also called a boot drive, system disk, or hard 

drive. , 

See set. 

An application program from Symantec that enables you to 
manage and organize fonts in the Macintosh OS. 

A font file in a suitcase. 

A program that loads into memory when you start your 
Macintosh and adds Suitcase functionality to the Macintosh OS, 

A folder on your startup drive that contains the files your 
Macintosh requires for operation, such as the System file, Finder, 
system extensions, desk accessories, and control panels. 

A font file that is stored in the Fonts folder of your System 
Folder. 

A font technology developed by Apple and Microsoft that both 
displays fonts on your screen and prints fonts on your printer 
smoothly, regardless of point size or resolution. 

A PostScript font format that uses hinting to print fonts clearly 
and smoothly. Type i fonts are also calied PostScript outline 

fonts. 

See also hinting, 

A collection of similarly designed and styled letters and 
characters referred to by the same name. An example of 4 
typeface is Times Bold. 

  

    

WYSIWYG WYSIWYG, or “What You See Is What You Get,” means that 

what you see on your screen is exactly what js printed on your 
printer. In Suitcase, the WYSIWYG menu option enables you to 
display fonts in Font menus exactly as they will appear when 
you print them.
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Index 

A 
AppleScript 

containment hierarchy, 7-1 
object and container hierarchy, 7-1 

objects and verbs, 7-1-7-3, 
reference books, 7-3 
sample script, 7-4 
using with Suitcase, 7-1 

AppleScript dictionary for Suitcase, 7- 3 . 
application sets, creating, 4- 5 

B 
bitmap fonts, C-8 

Cc 
containment hierarchy, Applescript, ma 1. 
conventions, ix 

D 
documentation usage, 1-2 

documents, precautions for sharing or 

transferring, 5-4 
drag and drop, using, 4-3 

E 
Edit menu, 6-2-6-3 

empty font suitcase, creating, 5-7 

F 
File menu, 6-1-6-2 
files, compressing, 5-6 
font concepts, Macintosh. See Macintosh 

font concepts 
font conflict, alert settings, 5-4   

font management. See Suitcase sets 

font organization 

alphabetical, B-2-B-3 

client- or job-centered, B-3~B-4 
font families, B-4-B-5 
methods, B-2 

font sets, creating, 4-4 

font status, showing, 4-15 
fonts 

adding to sets, 2-5, 4-6-4-8 

closing, 4-11 

getting information about, 4-13 
opening, 4-9 
opening temporarily, 4-10 

previewing in Sample panel, 4-14 
procuring, C-5-C-6 
quick open or close, 2-5 
removing, 4-13 
sorting in Sets window, 4-13 
using effectively, C-4—C-5 

Fonts window 
Fonts list, 6-10 
Sample panel, 6-11 
Show pop-up menu, 6-10 

G fee my . 

Guide menu, 6-5—6-6 

H 
hardware requirements. See requirements, 

minimum 

Hot-Key, specifying, 5-3 

I 

installing Suitcase, 3-1-3-5



    

  

   

M 
Macintosh font concepts, C-6 

bitmap fonts, C-8 

font organization, C-6—C-7 
font suitcases, C-7 

P 
PostScript fonts, C-8-C-1i - 

printing 

history, C-1 
terms, C-2-C-4 

Q 
quick start 

creating sets, 2-3-2-4 

increasing benefits of Suitcase, 2-2 
installation, 2-1 

Suitcase set information, 2-2 
QuickDraw GX fonts, C-13 

R 
requirements, minimum, xvi 

S 
Sets window 

command buttons, 6-8 
Info panel, 6-8 
list, 6-6 

software requirements. See requirements, 

minimum 
sound file, playing, 4-16 

Suitcase 

new features, 1-2 
purpose, 1-1 

Suitcase sets 

benefitting most from, 4-2 
closing, 4-11 
creating, 4-4-4-6 
different kinds, 4-2 

easy creation, 4-3 
Suitcase sets (continued) 

getting information about, 4-13 
opening, 4-9 
overview, 4-1 | 
quick open or close, 2-5 
removing, 4-13 
renaming, 4-12 

System Folder, removing fonts from, B-1 

T 
Tools menu, 6-4-6-5 
troubleshooting Suitcase, A-1—A-4 
TrueType fonts, C-11-C-13 
typesetting. See printing 

Vv 
View menu, 6-3-6-4 

WwW 
warn before closing, 5-3 
WYSIWYG Menus, displaying, 5-1 
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Symantec is committed to excellent service worldwide. Our goal is to provide you 

with professional assistance in the use of our software, wherever you are located. 

"Technical Support and Customer Service solutions vary by country. If you are 
outside the United States or Canada, please refer to the Worldwide Service and 

Support section at the end of this chapter. 

Registering Your Symantec Product 

To register your Symantec product, please complete the registration card included 

with your package and drop the card in the mail. You can also register via your 
modem during the installation process if your Symantec software offers this feature. 
In addition, you can use the toll-free fax number listed below to register your 

product, | . . 7 

If your address changes, you can mail or fax your new address to Customer Service. 

Please send it to the attention of the Registration Department. 

Symantec Corporation 

Attn: Registration Dept. 

175 W. Broadway, . 

Eugene, OR 97401 

(800) 800-1438 Fax
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This file contains the most up-to-date information about using Suitcase 3.0. Before 

using Suitcase, please read this file. 
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INSTALLATION: 

The Suitcase Installer places these files in the Suitcase 3.0 folder: 
Suitcase 3.0 application 

SimpleText application and Read Me file 

Suitcase Guide files (About Suitcase 3.0, Suitcase Guide, Shortcuts, Overview) 

Previous version of your Suitcase extension, renamed Suitcase 2.x Database 

(only if Suitcase 2.x is already installed on your Macintosh) 

Suitcase Scripting Examples.sea 

The Suitcase Installer places these files in the Extensions folder: 

Suitcase 3.0 extension 

ObjectSupportLib extension (Power Macintosh only) 

Macintosh Drag and Drop extension (System 7.1.x - if necessary) 

  

NOTES FOR SUITCASE 2.0 USERS: 

Do not move or delete the Suitcase 2.x Database icon in the Suitcase 3.0 

Folder. Suitcase needs it to convert your Suitcase 2.0 sets to Suitcase 

3.0 sets. 

( 
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If conversion of the database is not completed, the Suitcase 2.x 
Database will remain in the Suitcase 3.0 Folder. This may happen because 
some of your old sets contain fonts on volumes that were not mounted 

at conversion time. To resolve this, try mounting all remote font 

servers and re-launch Suitcase which will attempt to convert the 

database again. 

You can double-click a set or a font to open it. You are no longer 

required to add sets to the Permanent Set (now called the Startup Set) 
to open them. 

There is no longer a Temporary Set. You can now list temporary fonts in 

a separate window. 

  

OPERATING NOTES: 

e Suitcase 1.x - Database conversion from Suitcase 1.x is not supported. 

If you are upgrading from Suitcase 1.x, you'll need to recreate your 1.x 

sets in Suitcase 3.0. 

® ObjectSupportLib - This extension must be in your Extensions folder 
in order for Suitcase to run on the Power Macintosh. The Suitcase 
Installer ensures that you have ObjectSupportLib in your Extensions 

folder during an Easy Install, or during a Custom Install of the Suitcase 

application. If you don't already have ObjectSupportLib in your 

Extensions folder, the installer places it there. 

e Using fonts located on a remote drive - If a remote drive containing 

fonts managed by Suitcase becomes inaccessible, close the aliases of 
those fonts in the Suitcase Sets window. Otherwise, Font menus in your 

applications may take a long time to display. 

e Compressed items - When the Suitcase extension is not loaded, fonts 

in font suitcases which have been compressed by Suitcase 3.0 cannot be 
opened and viewed individually in Suitcase or in the Finder. To display 

  
 



  

  

these fonts wi ‘he extension inactive, first expand the font suitcase 

file containing them in Suitcase, then view as usual in the Suitcase 
application or in the Finder. 

e Playing Sounds - In the event you have difficulty playing large sounds 
in Suitcase, try allocating more memory to the Suitcase application. 

e Font Family Styles - Certain fonts identify a specific style in their 
font name, for example, Bookman SSi (italic) font. When viewing such 

fonts in the Font Preview box of the Sample panel, using style 
selections other than those indicated in the font's name may result in 

the font being displayed in the default application font (usually Geneva), 

not the font's typeface. 

¢ Simple Beep - In some instances, the Simple Beep sound may not be 

visible in the Sound control panel. To use Simple Beep, either use 

SimpleSound (System 7.5.3 or later) or restart your Macintosh with 

extensions off (hold down the shift key), select Simple Beep in the 
Sound control panel, then restart. 

  

COMPATIBILITY: 

e Microsoft Excel 5.0 - Excel 5.0 is unable to open application sets 

created for it in Suitcase. To open fonts to Excel, create a font set in 

Suitcase containing the fonts you want, and open this set in the Suitcase 

Sets window prior to launching the Excel application. Otherwise, only 
fonts that are already open on your Macintosh will be available to Excel. 

e FrameMaker 5 - With Suitcase WYSIWYG Menus active (either on or 

opened by Hot-Key), Font menus in FrameMaker display some fonts 

using their own fonts, and some fonts in Chicago. All fonts will appear 

correctly in FrameMaker documents on-screen and when printed. 

e PageMaker - In some instances, using modifer keys to access 

WYSIWYG Menus results in fonts in the PageMaker 5.0 or 6.0 Font menu 

displayed in Chicago font. Move your cursor over the fonts and they are 

c displayed in their own font. 
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e NOW _ WYSIWYG Menus 5.0.1 - The presence of this application disables 
the WYSIWYG Menu feature in Suitcase (that is, you can't control 

WYSIWYG Menus from the Suitcase Preferences dialog box if NOW is 

overriding Suitcase). 

e TrapWise - Launching TrapWise with LaserWriter 7 and Suitcase 
present will result in an error message: "Fonts not available." Click OK 
and TrapWise finishes launching. Luminous suggests using LaserWriter 8 
with Suitcase and TrapWise. 

e PowerTalk and DiskLock - When you install Suitcase onto a Macintosh 

running System 7.5.2, PowerTalk Extension, PowerTalk Manager and 

DiskLock at the same time, you may experience a crash at startup. We 

suggest updating to System 7.5.3 and PowerTalk 1.2.3. 

e Time Palette (and other applications using items that share names 

with fonts) - lf WYSIWYG Menus are active, an item that has the same 

name as a font on your Macintosh may appear in an application's menu 

drawn in the font that shares its name. For example, Time Palette has 
pop-up menus of cities around the world, including New York. If the font 
New York is installed on your Macintosh, the New York pop-up menu in 

Time Palette appears in New York font. This does not cause problems, 

but it can be avoided by turning off WYSIWYG Menus in Suitcase. 

e Omnis 7 ~ Suitcase is unable to launch when you have Omnis 7 version 

3.2 running on your Macintosh. If you experience this problem, please 

contact Omnis technical support. 

e Eclipse - Users of the Eclipse screen saver may experience conflicts 
with applications (like Suitcase) that use AppleEvents. 

* Type Reunion (ships with Adobe Illustrator 5.5) - Causes the Font 

menus of many applications to display Suitcase and system fonts 

incorrectly (they are not displayed at all or are displayed in the 
incorrect font). Press shift to override Type Reunion and correctly 

display Font menus. 

  
 



  

  

¢ Type Tamer - If you use Type Tamer and are unable to access a font 

even though the font is open and the application's Font menu displays 
the font, re-launch Type Tamer to make the font available. 

e EAsy Color - This extension needs to load before the Suitcase 

extension, which occurs normally if you don’t rename either extension in 

such a way that the Suitcase extension loads first. 

e Super ATM & Adobe Acrobat Reader - These packages include three 

fonts required to perform font substitution: Adobe Sans MM, Adobe 

Serif MM, and Symbol. We suggest leaving all three fonts in the Fonts 
folder of the System Folder. NOTE: You may not be able to view 

individual instances of these fonts as System Fonts in the Fonts window 

even though they are open to the System. 

e HP Fonts - When viewing HP Fonts in the Suitcase Fonts window, 

Suitcase may indicate that a font suitcase contains the Chicago font 

when the Chicago font is not actually present. 

  

INTERNATIONAL ITEMS 

e Kanji or other Non-Roman script systems - Hot-Keys cannot be used 

to launch Suitcase. To launch Suitcase, double-click the Suitcase icon or 

choose Suitcase 3.0 from the Apple menu. 

e EG Word - EG Word users may experience conflicts with applications 

(like Suitcase) that use AppleEvents. ErgoSoft, makers of EG Word, have 
posted EG Word 6.1, which solves this problem. 

  

TECHNICAL SUPPORT 

Symantec offers unlimited use of a fax retrieval system that provides 
product information and technical notes. For product literature and 
press releases, access this service by dialing (800) 554-4403. For 
technical information, dial (541) 984-2490. 
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If you have questions after consulting the Suitcase manual, on-line help 

system, Read Me file, or Fax Retrieval System, you may wish to call our 

Technical Support Team. For information regarding Symantec Technical 
Support, please refer to the "Symantec Customer Service Plan" at the 
back of your Suitcase manual. If you are outside the USA, please refer to 

manual pages SSS-6, SSS-7, and SSS-8 or contact your local Symantec 

dealer for information about obtaining technical support. 

Symantec Corporation 

Technical Support phone line: (541) 465-8440 
7:00 AM to 4:00 PM Pacific Time 
175 W. Broadway 

Eugene, OR 97401 

We can also be reached through electronic mail on the following on-line 

services: 

America Online: Keyword: SYMANTEC 
CompuServe: GO SYMUTIL 
AppleLink: NORTON.TECH 

Symantec also maintains a user-to-user BBS, from which you can obtain 

tips and information: 

Symantec BBS: 
300 - 28,800 baud: (541) 484-6669 

300 - 14,400 baud: (541) 984-5366 

Settings: 8, None, 1. 

Symantec's international partners are located throughout the world. 
Please call our Customer Service Center in Oregon at (541) 334-6054 or 

(800) 441-7234 for the name, address, and phone number of the 

international office closest to you. 

  
 


